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1.	 You can download and print the Class Notes for personal use, but you may not share them. 

2.	 Once you have watched all the videos and completed all the quizzes, reflections, tasks and 
assessments successfully, you can download your certificate and print it. 

3.	 If you wish to earn SACE Professional Development (PD) points for this session, you must 
complete all the online assessments in the session successfully. Our system will notify us of 
your success, and we will send the points allocation request to the South African Council for 
Educators (SACE). 

4.	 Please remember that devices and apps are updated all the time, so the device specifications, 
app features and icons that you see here might differ slightly depending on the device you’re 
using and any subsequent app updates. 

Important information
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Outcomes and content
Outcomes of the session

By the end of this session, you will:

•	 understand the purpose of a spreadsheet  

•	 understand the concepts of a cell, a row, a column and 
sheet

•	 understand the use of Cell References 

•	 know how to format and edit cells (key in data, wrap text, 
merge and unmerge cells, align text, add borders and 
shading and adjust text direction)

•	 know how to use The Autofill Feature 

•	 know how to use number formats (Plain Text, Number, 
Currency, Time and Date)

•	 know how to resize rows and columns

•	 know how to format and edit spreadsheets (Paper Size, 
Page Margins and Page Orientation)

•	 know how to set a print area and print titles (gridlines and 
repeat rows/columns)

Content of the session

This session will focus on:

•	 transferring common features from word processing skills

•	 understanding the basic concepts of Sheets

•	 formatting and editing cells

•	 using the Autofill Feature 

•	 using number formats 

•	 resizing rows and columns

•	 sorting data

•	 formatting and editing spreadsheets
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Overview
Welcome to Session 6 of the Vadea Google Workspace Course. This session, Processing 
numerical data using Google Sheets, Part 1 is the first of two sessions that will take you 
through the steps of discovering how useful numerical data processing apps like Google Sheets 
can be to you as a teacher. We will create documents to use in your teaching during these 
sessions. In this session, we will create a class list.

There are regular tasks and quizzes just to check that you are developing the knowledge needed 
to move on.

Remember that devices and apps are updated all the time, so the app features and icons that 
you see here might differ slightly from the app in which you are working.
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What is numerical data 
processing?

Numerical data, spreadsheets and apps

Teachers are required to work with many sets of numerical 
information (or data) at times. Think, for example, of test and 
exam marks and calculations. We also need to work with 
numbers in our personal lives. We might need to keep track 
of expenses, or even to perform complex calculations. Some 
of us are intimidated by the notion of working with many sets 
of numbers, and many people feel out of their depth when 
they start working with numerical information in computer 
programs. 

However, spreadsheet software is a useful means of processing 
numerical data on your computer. It will help you to manage 
data quickly, and also to analyse and present data efficiently.

As a teacher, using spreadsheets will make your life easier. 
Preparing class lists, calculating test scores in marksheets, 
or keeping track of a school fundraiser are just a few of the 
many ways in which you can use spreadsheets in classroom 
management and for record keeping.

When it comes to apps for processing numerical data, there 
are many options available to you. All options have the same 
basic abilities. They allow you to organise, analyse, and store 
numerical data in table form. All the apps will allow you to 
perform a range of calculations on your numerical data. Once 
you have your data set out in a neat, logical and organised 
format and you’ve performed the necessary calculations, you 
can present the data in a visual format. Spreadsheet apps allow 
you to create charts and graphs of your data for easy analysis 
and interpretation.

Microsoft Office Excel

Excel is the spreadsheet offering from Microsoft. It is a popular 
choice. There are free options, but the best productivity is 
achieved in the paid versions.
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LibreOffice Calc

LibreOffice Calc is another option.

Google Sheets

Google Sheets is the spreadsheet software in Google 
Workspace. We will focus on this app during Sessions 5 
and 6 of this course. But many of the tools you will get to 
know during the course are similar to those offered by other 
spreadsheet apps. Once you’ve completed our Google Sheets 
sessions, you will be able to use what you’ve learned in any 
other spreadsheet app as well.

Where will you work?

Google Workspace – the suite containing all Google’s Apps 
– was developed to be used online on the internet. All the 
apps run in a web browser on a computer, mobile phone, or 
a tablet device. The advantage of this is that you can start a 
presentation in Google Sheets on one device, and then work on 
it on another device because all changes are synchronised (we 
usually just say synced) in Google Drive.

You can work in Google Sheets in a web browser

1.	 Open your web browser (Google Chrome is the best to use 
in this instance). 

2.	 Sign into your Google Account. When you use Chrome, 
you will be able to do this on the right-hand side of the 
screen. 

3.	 Click the Nine Dot Menu. 

4.	 Select Goolge Sheets. 

5.	 Google Sheets will open up in your browser.

You can work on Google Sheets on your mobile device

1.	 Go to your app store. This will be Google Play Store for 
Android, or the App Store for iOS devices.

2.	 Download the app if it is not already installed on your 
device. It is possible that your Android device already has 
all the Google Apps. It depends on who made your device. 
Look on your device first, and if it is not there, go to the 
Google Play Store and download and install it.

3.	 Now you can use the app on your smartphone or tablet 
device even if you are offline. When you go online, the 
changes will sync for you.
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Reflection
•	 Make notes in your PD Journal.

•	 List three on-paper administrative and/or record-keeping 
documents you use in your classroom.

•	 How could they be transformed into digital documents?

You can download a shortcut to any of the Google Apps 
onto your computer 

1.	 Google does not have an app for computers, but you can 
create a special shortcut very easily. This will have the same 
functions as the online version of the app. You can work 
offline via the app shortcut on your computer, and it will 
sync with your Google Drive when you next go online.

2.	 Launch the Chrome browser. 

3.	 Sign into your Google Account. 

4.	 Click on Google Sheets. 

5.	 Click on the Three Dot More Options Menu at the top of 
the screen. 

6.	 Click Save And Share. 

7.	 Click Create Shortcut. 

8.	 In the pop-up that opens, type in the name of the app, in 
this instance Google Sheets. 

9.	 Click the Create Button. 

10.	 A pop-up will appear to ask if you would like to add the 
shortcut to your Taskbar. Select ‘Yes’ if you want to pin it 
there. 

11.	 You will find the app on your desktop. 

12.	 You can follow this same process to get a shortcut for any 
other Google App on your computer.
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Producing a class list
Getting started with Google Sheets

Once you have Google Sheets open, you are ready to learn 
about data processing apps.

Google Sheets files are called spreadsheets, and each 
spreadsheet is made up of one or more sheets or worksheets. 
One spreadsheet can have many sheets in it.

You can create a new blank spreadsheet

1.	 Open Google Sheets.

2.	 Click the Plus Sign or the Templates Button.

You can create an additional new blank spreadsheet when 
you already have another spreadsheet open

1.	 Click the Sheets Home Button.

2.	 Click the Plus Sign or the Templates Button.

3.	 Or, click File, then New, then Spreadsheet. 

You can name a spreadsheet

1.	 Click Untitled Spreadsheet at the top left.

2.	 Type in the name of the spreadsheet.

3.	 Google will automatically save the spreadsheet to your 
Google Drive. 

You can open a saved spreadsheet

1.	 Click on the File Menu.

2.	 Click on Open.

3.	 Select the file from the options: Recent Files, My Drive, 
Shared with me, Starred, Computers or Upload.

4.	 Left-click the spreadsheet, or click on Sheets Home.

5.	 Select a file.

Saving a spreadsheet

There is no Save Button in Google Sheets. Your files are 
automatically saved to Google Drive when you are online. If you 
are offline, your file will synchronise to Google Drive when you 
go online again.
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Exploring Google Sheets

10 11 12 13 14 15 16 17 18 19 20 21 22 24 25 26 2723

1 4 5 6 7 8

2

3

9

1.	 Web address of the Google Sheets Spreadsheet.

2.	 Sheets Home Button.

3.	 Title of spreadsheet: It always starts as Untitled Spreadsheet. 
Click here to name your spreadsheet. With Google 
Sheets, there is no Save Button. Google will keep saving 
automatically while you are online. If you happen to go 
offline, then Google will save the changes you have made 
and upload them.

4.	 Star Button: Starred files are files that you want to sort and 
have available by clicking on the Starred Option in Google 
Drive. 

5.	 Comment History Button.

6.	 Google Meet Button: Click here if you want to join a Google 
Meet call.

7.	 Sharing Button.

8.	 Your profile.

9.	 Menus: File, Edit, View, Insert, Format, Tools, Extensions, 
Help. These menus contain the various commands you can 
use in your spreadsheet. 

10.	 Search the Menus for an action.

11.	 Undo the last thing you did.

12.	 Redo what you just undid.

13.	 Print.

14.	 Paint Format: This button allows you to copy the formatting 
from one cell to another.

15.	 Zoom.

16.	 Format as Currency: This button allows you to show the 
numbers in a cell as a currency like the British Pound, the 
South African Rand, or any other currency you set. 
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17.	 Format as Percentage.

18.	 Reduce Decimal Places.

19.	 Increase Decimal Places.

20.	 More Formats: This button allows you to change the 
formatting of numbers to various options like date, time, 
and percent. It also allows you to set the currency to your 
country’s currency. 

21.	 Font.

22.	 Font size.

23.	 Format: Bold, Italics, Strikethrough, Text Colour.

24.	 Fill Colour: You can fill a cell with a colour to highlight 
information.

25.	 Borders: You can place borders around the cells. Usually 
there are only gridlines that do not print around a cell.

26.	 Merge Cells. 

27.	 Three Dot Menu: Click here for more options.

When you click on the Three Dot Menu, the following additional 
options will appear.

The Option Icons from left to right are listed below.

1.	 Horizontal Align: This changes the horizontal (left, centre, 
right) alignment of text in cells.

2.	 Vertical Align: This changes the vertical (top, middle, 
bottom) alignment of text in cells.

3.	 Text Wrapping: If you have long strings of text, this button 
makes the text fit the cell but creates more lines of text in 
the cell.

4.	 Text Rotation.

5.	 Insert Link.

6.	 Insert Comment.

7.	 Insert Chart. 

8.	 Create a Filter. 

9.	 Filter Views.

10.	 Functions: These are formulae. (You will learn more about 
formulae in Session 6 of this course.)

1 2 3 4 5 6 7 8 9 10
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Here is an open spreadsheet.

1 2

4

6 7 8
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5
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1.	 Name Box: This shows the current cell that is selected (in 
this instance, Cell F1).

2.	 Formula Bar: This is where you’ll insert formulae.

3.	 Column Headings: Alphabetically running from A, B, C 
onwards. 

4.	 Row Headings: Running numerically from 1, 2, 3 onwards. 

5.	 Cell: Each block is called a cell. When you click on a cell, 
you will see the Cell Name/Cell Reference in the Name Box. 

6.	 Add Sheet.

7.	 All Sheets: This allows you to switch between the various 
sheets in the spreadsheet. We will be creating a blank 
spreadsheet in Google Sheets. Remember that one 
spreadsheet can have many sheets in it.

8.	 Sheet Name: The name of an individual sheet.

9.	 Vertical Scroll Bar: This enables scrolling up and down.

10.	 Horizontal Scroll Bar: This moves the sheet towards the left 
or the right.
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Using what you know from Google Docs

Because Docs and Sheets are both Google Workspace 
products, you will already have noticed many similarities to 
Docs in the look and layout of Sheets. You already know all the 
basics!  

What you want to do Docs and Sheets 
shortcut: PRESS

Copy and paste text Control C, Control V

Format text (bold, italics and underline) Control B, Control I, 
Control U

Align the text in the centre of a 
document/cell

Control E

Align the text on the right in a 
document/cell

Control R

Align the text on the left in document/
cell

Control L

Highlight all the text in a document/cell Control A

Print a document Control P

Keying in text

Simply type or key in text or numbers into a cell as you have 
learned. Later, you will learn more about the types of text you 
can include in a cell. If you want to make a line space in a cell, 
press Alt and Enter on your keyboard.

Task
•	 Open Google Sheets in your browser.

•	 Open a new spreadsheet and identify some of the 
components we have just covered.

•	 Name your spreadsheet: My class list.
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Resizing rows and columns

If the text is too long for the column or row, you can resize the 
column or row. 

You can resize a row

1.	 Select the row to resize by clicking on the row heading.

2.	 Move your cursor to the right-end of the row heading. You 
will see that the cursor changes to a cross with arrows on 
the vertical line.

3.	 Click and hold the Left Touchpad Button.

4.	 Drag the cursor down, adjusting the height to how high 
you want your row to be.

You can resize a column

1.	 Select the column to resize by clicking on the column 
heading.

2.	 Move your cursor to the right-end of the column heading. 
You will see that the cursor changes to a cross with arrows 
on the horizontal line.

3.	 Click and hold the Left Touchpad Button.

4.	 Drag the cursor to the right, adjusting the width to how 
wide you want your column to be.

Task
•	 Enter the names and surnames of your class into your 

spreadsheet. 

•	 Resize the columns to fit the longest surnames and names 
in your class list.
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Formatting and editing cells

Selecting cells

You can select one cell

1.	 Move your cursor to the cell you want to select.

2.	 Click once in that cell.

3.	 The cell will be highlighted with a blue frame.

You can select many cells that touch each other

1.	 Move your cursor to the first cell you want to select. 
Remember, we normally work from left to right, top to 
bottom, so start with the highest cell that is furthest to the 
left.

2.	 Click and hold down the Left Touchpad Button. Keep 
holding the button down while moving across and down to 
select all the cells you want to select.

3.	 Once you have selected all these cells, release the Left 
Touchpad Button.

4.	 The selected cells will be highlighted in blue with a blue 
frame around all of them.

You can select many cells that do not touch each other

1.	 Move your cursor to the first cell you want to select. 

2.	 Click and hold down the Left Touchpad Button. 

3.	 Press and hold down the Control Key.

4.	 Click in each cell you want to select with the Left Touchpad 
Button. When you have selected the cells you want, release 
the Control Key.

5.	 The selected cells will be highlighted in blue. 

Fonts

You can change the font before you key in text

1.	 Click the Font Button on the Toolbar.

2.	 Scroll through the different fonts and click on your 
preferred font.

You can change the font after you key in text

1.	 Highlight your text.

2.	 Click the Font Button on the Toolbar.

3.	 Scroll through the different fonts and click on your 
preferred font.
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You can change the font size before you key in text

1.	 Click the Font Size Button on the Toolbar.

2.	 Scroll through the different font sizes and click on your 
preferred font size.

You can change the font size after you key in text

1.	 Highlight your text.

2.	 Click the Font Size Button on the Toolbar.

3.	 Scroll through the different font sizes and click on your 
preferred font size.

You can use an alternative way to change the font size 
after you key in text

1.	 Highlight the cell.

2.	 Click the Increase Font Size Button or Decrease Font Size 
Button on either side of the Font Size Button.

You can change the font to bold, italics, and underline 
before you key in text

1.	 Click the B for Bold, I for Italics or U for Underline Button on 
the Toolbar before you key in text.

2.	 To stop the change in style, click the same button again.

You can change the font to bold, italics, and underline 
after you key in text

1.	 Highlight your text.

2.	 Click the B for bold, I for Italics or U for Underline Button on 
the Toolbar.

3.	 To stop the change in style, click the same button again.

Borders and shading

You can add cell borders

1.	 Borders frame cells and provide the grid structure when 
spreadsheets are printed. Remember that even though you 
see the grey lines around cells on the screen, they will not 
appear when your sheet is printed. 

2.	 Select the cells to which you want to add borders.

3.	 Click the Borders Button on the Toolbar.

4.	 Select where you want your borders: On the top of the cell 
only, at the left of the cell only, at the right of the cell only, 
on the bottom of the cell only or all around the cell  
(All Borders).

5.	 Select the colour you want the border lines to be.

6.	 Select how thick you want the border lines to be using the 
Border Styles Button.
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You can add shading to cells

1.	 Shading helps to highlight certain cells over others. We 
often shade the column headings to have them stand out 
from the other cells below. 

2.	 Select the cells to which you want to add shading.

3.	 Select the Fill Colour Button on the Toolbar.

4.	 Select the colour you want for your shading. 

Wrapping text

The Google Sheets Text Wrapping Feature can help you to 
display longer text in a cell without it overflowing to other cells. 
Wrapping text means displaying the cell contents in many lines, 
rather than in one long line. You have learned that you can 
change the column width to accommodate longer sections of 
text or numbers. Sometimes you might want to split the text 
over many lines. 

You can split text over many lines

1.	 Select the cell or cells where you want text to be displayed 
over many lines.

2.	 Click the Text Wrapping Button on the Toolbar. 

3.	 Choose Wrap from the options.

4.	 Your text will now be displayed over many lines. Notice that 
the row height is automatically adjusted to fit all the lines of 
text. 

Merging and unmerging cells

If your data forms part of a table, you may need to merge cells 
(combine them) for ease of reading or for display purposes. 
You may also need to split cells that are currently combined. 
This is called unmerging in Sheets.

It is important to remember that you should merge cells in the 
table before you insert your data. If you merge two or more 
cells with different data, you will get the following warning.

If you continue, you will lose all the data in the cells below the 
first cell.
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You can merge cells

1.	 Select the cells to merge. Check that only one cell has data 
in it, or that the same data is in every cell.

2.	 Click the Merge Cells Button on the Toolbar.

3.	 The selected cells will be combined. You will notice that the 
cell contents have been aligned to the bottom of the cell. 
You can use the Vertical Align Button to change this.

You can unmerge cells

1.	 Select the cells to unmerge.

2.	 Click on the Merge Cells Button on the Toolbar. The cells 
will be separated again.

Note, there is a drop-down menu to the right of the Merge 
Cells Button. You can use this to merge and unmerge selected 
cells too. You will also find the Merge Cells Option on the 
Format Menu.

Alignment

We can change the position of the text in a cell. The position is 
referred to as the alignment of the text. We have options for 
vertical alignment and for horizontal alignment. 

For vertical alignment, the options are top-, middle- and 
bottom-align. For horizontal alignment, the options are left-, 
centre- and right-align.

You can change the alignment of the text in a cell

1.	 Select the cell with the text that you want to realign.

2.	 On the Toolbar, look for the Horizontal and Vertical Align 
Buttons. Click on the drop-down menu of either button and 
select how you want to align your text. 

3.	 Left-click on the touchpad to select your option.

Text direction

From time to time, you will need to write longer text in a narrow 
column. This could happen when you want to list many subjects 
in a heading, or if, for example, all the months of the year must 
be in the column heading. In these instances, it would be better 
to list the column heading vertically. We can do this in Sheets 
by changing the direction of the text.
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You can change the direction of the text in a cell

1.	 Select the cell in which you want to change the direction of 
the text.

2.	 Click on the Text Rotation Button on the Toolbar.

3.	 From the list of options, select the direction or orientation 
of the text that you want.

4.	 Left-click on the touchpad.

Task
•	 Update your class list now. 

•	 Apply what you have learned about formatting and 
editing cells. 

•	 Try to get yours to look as close to the sample below as 
possible.
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Task
•	 Practise using the Autofill Feature.

•	 Add numbers next to the names of learners in your class 
list.

Using the Autofill Feature

At times, you may have to enter a lot of repetitive data in 
Sheets, such as the same formula in rows of learner’s marks 
for example, or you may need to number the learners on the 
class list. To do this manually would take time and energy, but 
there is an automated way to do this that is called the Autofill 
Feature.

You can use the Autofill Feature to fill cells with data

1.	 Click in the cell in which the data is that you want to 
duplicate.

2.	 Put the cursor over the bottom right-hand corner of the 
cell until it turns into a black plus sign.

3.	 Click and hold the Left Touchpad Button and drag the plus 
sign over the cells you want to fill with this data.

You can use the Autofill Feature to automatically number 
a list

1.	 Type the first two numbers in your list.

2.	 Put the cursor over the bottom right-hand corner of the 
cell until it turns into a black plus sign.

3.	 Click and hold the Left Touchpad Button and drag the plus 
sign over the cells you want to fill. You can drag vertically 
or horizontally so long as you have entered the first two 
numbers in a series.

You can use the same steps to fill in the date with the 
Autofill Feature

Note, if the first two cells form a series of dates or numbers (1, 
2, 3 etc.), the series will continue across the selected cells.

If the first two cells do not form a series of dates or numbers, 
the list of values will repeat across the selected cells.
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Formatting numbers

In Sheets, you can format numbers in cells for currency, 
percentages, or dates, depending on the content of a specific 
cell. When you deal with learner test scores, for example, you 
will want to use percentages. When preparing a budget for 
a class excursion, you will use the currency format to enter 
different monetary values.

The formats that you will use most often are Plain Text, Number, 
Currency, Date, Time, Percentage and Text.

Automatic and Plain Text

Google Sheets applies Automatic Formatting to anything you 
type, making the decision based on the text you enter, numbers 
or text. 

You may wish to change this to Plain Text. For the most part, 
numbers that are formatted with the Plain Text Format are 
displayed just the way you type them. However, if the cell is 
not wide enough to show the entire number, the Plain Text 
Format rounds the numbers with decimals. This format also uses 
scientific (exponential) notation for large numbers of 12 or more 
digits.

Look at this example. Here, the Scientific Format is selected. We 
will go through some of the other types of format as well.
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Number

This format is used for the display of numbers. 

You can decide on the number of decimal places that you 
want to use

1.	 Type the number into the cell.

2.	 Click the More Formats Button on the Toolbar.

3.	 Select Number.

4.	 On the Toolbar, to the left of the More Formats Button, 
click on the Decrease Decimal Spaces or Increase 
Decimal Spaces Button to remove or add decimal spaces 
respectively.

You can use a thousands separator (1 000 000)

1.	 Type the number into the cell.

2.	 Click the More Formats Button on the Toolbar.

3.	 Select Number.

4.	 Google Sheets will automatically insert the thousands 
separator.

Currency

This is used for general monetary values and displays the 
default currency symbol with numbers. 

This could be, for example, the symbol for Rand, Dollar, or Euro.

You can change the currency in a spreadsheet

1.	 Type the amount of currency you want into the cell.

2.	 Click on the More Formats Button.

3.	 Select Custom Currency. 

4.	 Choose the currency you want. You can specify the number 
of decimal places that you want to use, whether you want 
to use a thousands separator, and how you want to show 
the currency name using the drop-down menu.

5.	 Click Apply. 

Date

This format displays date and time serial numbers as date 
values.

As usual, you will click the More Formats Button to insert a date 
format. Each spreadsheet has its own settings, and this may not 
be the date format you are used to.
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You can change the date format system

1.	 Click on the File Menu.

2.	 Select Settings.

3.	 In the dialogue box, click the drop-down menu next to 
United States.

4.	 Select United Kingdom from the list of alternatives.

5.	 Click Save and Reload.

You can customise the date format 

1.	 Select the cell with the date in it.

2.	 Click the More Formats Button on the Toolbar. 

3.	 Select Custom Date and Time Formats.

4.	 Decide how you want the date formatted.

5.	 Click Apply.

Time

This displays time serial numbers as time values, according to 
the type and location that you specify in Settings.

You can customise the time format

1.	 Select the cell with the time in it.

2.	 Click the More Formats Button on the Toolbar. 

3.	 Select Custom Date and Time Formats.

4.	 Decide how you want the time formatted.

5.	 Click Apply.

Percentage 

This format multiplies the cell value by 100 and displays the 
result with a percent symbol. You can specify the number of 
decimal places that you want to use.

Please remember that this is a display tool, not a calculation 
tool. Do not use this unless you have already done a calculation 
and have a fraction as an answer.

Look at this example.
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Task
•	 Play around with some numbers in your class list. 

•	 Change their formats and see how the numbers in the 
cells are displayed for different formats.

The learner achieves 36 out of 40 for a test. Calculate the 
percentage.

After you press enter your result is 0,9.

Go to More Formats, and select Percentage. Google will convert 
the number to a percentage.
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Formatting and editing spreadsheets

We have explored how to format the individual cells, now we  
will focus on the whole spreadsheet.

Google Sheets does not have a File and Page Setup Option. 
Rather, you adjust the spreadsheet settings like Print Area, 
Paper Size, Page Orientation, Margins, Page Breaks and other 
formatting after you choose the Print Options.

For each of the following options, start with your Google Sheet 
Spreadsheet open. Click the File Menu, and then select Print.

As you adjust each setting in the Toolbar on the right, the 
display will change to show your selected options. You can 
change as many of the settings as you want until you see the 
formatting and layout you want in the preview window. 

You can format your spreadsheet display

1.	 Print Area: Current sheet, workbook or selected cells.

2.	 Paper Size: Choose from a variety of preset sizes or enter a 
custom size.

3.	 Page Orientation: Landscape or Portrait Orientation.

4.	 Scale: Fit to width, height, or page, or enter a custom 
percentage.

5.	 Margins: Normal, narrow, or wide, or enter a custom size.

6.	 Page Breaks: Drag the blue dotted lines to change the 
edges of the page on the sheet.

7.	 Formatting: Add gridlines or notes, adjust page order, 
choose horizontal (centre, left or right) and/or vertical (top, 
middle or bottom) alignment options.

8.	 Headers and footers: Page numbers, title, name, date, time, 
etc.

You can print the header rows on each page

1.	 Click the View Menu.

2.	 Select Freeze.

3.	 Select the Header Row Option (most often this is Row 1).

4.	 The Freeze Option will display the top row even when you 
scroll down. 

5.	 Click the File Menu and select Print at the top left. Click 
Print. 
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Task
•	 Explore the different Layout Options in the Print Options 

Menu.

•	 Change the Page Orientation to Landscape.

•	 Change the Page Setup to repeat the first row.

6.	 Click on Headers and Footers in the Toolbar on the right.

7.	 Scroll down to select Repeat Frozen Rows.
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About the Final Assessment
At the end of this training session, you will be asked to 
complete the Final Assessment.

If you complete the Final Assessment successfully, you will 
qualify for your virtual badge and certificate. You can see a 
sample here.

In partnership with the Department of Basic Education.

Certificate
VIA AFRIKA DIGITAL EDUCATION ACADEMY

has successfully completed the attendance and 
assessment requirements of:

PROCESSING NUMERICAL DATA 
USING GOOGLE SHEETS, PART 1

This training is endorsed for 5 SACE Professional Development points.

Date Christina Watson
Chief Executive O�cer

SA
M
PL
E
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Final Assessment
Indicate the ONE correct response for each question.

1 In Google Sheets, what are individual files called?

a Documents

b Workbooks

c Spreadsheets

2 How can you create a new blank spreadsheet in Google Sheets?

a Click the Plus Sign Icon or the Templates Button.

b Click the Save Button.

c Click the Print Button.

3 What happens when you click on Untitled Spreadsheet at the top left in Google Sheets?

a It opens a new spreadsheet.

b It allows you to name the spreadsheet.

c It deletes the current spreadsheet.

4 How are Google Sheets saved?

a By clicking the Save Button.

b By pressing Control S.

c They are automatically saved to Google Drive when you go online.

5 What does the Text Wrapping Feature in Google Sheets allow you to do?

a Change font size.

b Split text over many lines within a cell.

c Merge cells.

6 Which option in Google Sheets allows you to add a cell border?

a Borders Button.

b Shading Button.

c Alignment Button.

7 How can you merge cells in Google Sheets?
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Indicate the ONE correct response for each question.

Final Assessment (continued)

a Select the cells to merge and click the Merge Cells Button.

b Click the Shading Button.

c Use the Text Rotation Button.

8 How can you use the Autofill Feature in Google Sheets?

a By clicking the Autofill Button.

b By dragging the plus sign over cells you want to fill.

c By pressing Control A.

9 Which format is used for displaying monetary values in Google Sheets?

a Date

b Currency

c Percentage

10 How can you change the number of decimal places for a number in Google Sheets?

a By clicking the Increase Font Size Button.

b By clicking the More Formats Button and selecting Number.

c By pressing Control C.

11 How can you print header rows on each page in Google Sheets?

a Click the View Menu and select Freeze.

b Click the File Menu and select Print.

c Click the Headers and Footers Option in the Toolbar.

12 What does the Freeze Option do in Google Sheets?

a Locks your computer.

b Displays the top row even when you scroll down.

c Deletes selected cells.
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13 Which option allows you to adjust the paper size in Google Sheets?

a Margins

b Page breaks

c Paper size

14 How can you select many cells that do not touch each other in Google Sheets?

a Hold down the Control Key and click each cell.

b Click and hold the Left Touchpad Button and drag.

c Press Shift and click on the cells.

15 What is the purpose of the More Formats Button in Google Sheets?

a To insert images.

b To change cell colours.

c To format numbers and text.

Indicate the ONE correct response for each question.

Final Assessment (continued)
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